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ABOUT NEOAC

We are an informal group of Apple users and enthusiasts. We 
have members of all levels of computer expertise using all 
types of Macs and Apple products.

Annual dues are $20.00 per family. In September, the cost for 
a new membership through the end of the year is $10. To join 
or renew your membership, you can either pay at a meeting, 
on our web site or mail a check made out to “NEO Apple 
Corps” and send to the post office box noted above.

Dues include access to our listserv (an online bulletin board 
where you can post questions and/or comments at any time), 
a PDF of our monthly newsletter and the opportunity to 
participate in our monthly raffle for valuable Apple and Apple-
related products.

MEMBERSHIP RENEWAL
Thanks to those members who have renewed. Dues are $20 
and include any family members that you can claim on your 
taxes. Membership privileges include participation in the 
raffles, the listserv, and picnic attendance. Prospective 
members should fill in the form on the last page.

MEETINGS
Unless otherwise noted, NEOAC 
meetings start at 9:30 a.m. on the 
fourth Saturday of each month at the 
Strongsville Public Library.

Strongsville Public Library
18700 Westwood Drive 
Strongsville, OH 44136
(directly behind the police station) 
440-238-5530 
<DIRECTIONS>

NEXT MEETING
September 22

UPCOMING MEETINGS
October 27
November 17
December 15
January 19 (3rd Saturday) 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How to Take Photos and Scan Documents with Continuity Camera in 
Mojave
JOSH CENTERS 

https://tidbits.com/2018/09/27/how-to-
take-photos-and-scan-documents-
with-continuity-camera-in-mojave/
One of the cool things about living in 
the Apple ecosystem is how your 
various Apple devices can interact 
with each other through Continuity, 
which includes features like auto-
unlocking your Mac by wearing your 
Apple Watch, automatically moving 
copied text across devices, sharing 
files via AirDrop, and taking calls 
anywhere with Wi-Fi Calling.
In macOS 10.14 Mojave, Apple has 
expanded these capabilities with 
Continuity Camera, a new feature that 
lets you take pictures or scan 
documents with an iOS 12 device and 
have them immediately show up on 
your Mac—either on the Desktop or in 
a document. If you’ve ever been 

working on your Mac and needed to 
email someone a scan of a receipt 
that’s sitting on your desk, you’re 
going to love Continuity Camera.
Requirements and Controls
As with many system-level features, 
Continuity Camera requires explicit 
support in apps. Unsurprisingly, many 
of Apple’s apps offer Continuity 
Camera in Mojave, including the 
Finder, Mail, Messages, Notes, 
TextEdit, Pages, Keynote, and 
Numbers. I haven’t yet heard of any 
third-party apps that have added 
support, but let us know in the 
comments if you run across any.
Continuity Camera has a few basic 
requirements: the Mac and iOS device 
need to be on the same Wi-Fi 
network, and they must be logged into 
the same Apple ID. Check the latter 
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on your Mac in System Preferences > 
iCloud and in iOS under Settings > 
Your Name.
How you access Continuity Camera 
varies somewhat by app, but the most 
common way is to Control- or right-
click where you want the photo or 
scanned document to appear. If you 
have only one device, you will see a 
subhead for the device, like iPhone X, 
above commands for Take Photo and 
Scan Documents. If you have multiple 
devices, you’ll see an “Import from 
iPhone or iPad” submenu, under 
which those commands will be 
replicated for each device.
In many of Apple’s apps, you’ll also 
see Import from iPhone as a submenu 
in the File menu, although that 
submenu moves to the Insert menu in 
Pages, Keynote, and Numbers. Plus, 
in Mail composition windows, there’s a 
drop-down menu on the right side of 
the toolbar that includes the Take 
Photo and Scan Documents 
commands.
For simplicity’s sake, I’m going to 
focus on importing images to the 
Desktop, but the process is the same 
regardless of whether you’re in the 
Finder or some other app.! If you’d like 
to watch a quick visual guide to 
Continuity Camera, I made a short 
video explaining how to use it.
Take Photos with Continuity 
Camera
Here’s how to take a photo with 
Continuity Camera:

1. Control-click your Desktop.
2. In the contextual menu, choose 

Import from iPhone > Take Photo.
3. A dialog or popover (the latter in 

apps) appears on the Mac screen, 
and a simplified version of the 
Camera app opens on your 
iPhone. You don’t get many 
options, but you can switch 
between the front- and rear-facing 
cameras, and tap the flash  icon to 
turn the flash on, off, or set it to 
auto (the default). You can also 
pinch out to zoom or tap the 2x 
button on iPhones with two rear-
facing cameras.

4. Frame your subject in the 
viewfinder and tap the shutter 
button.

5. Tap Use Photo to save the photo 
to the Mac’s Desktop as a JPEG. If 
the photo isn’t to your liking, you 
can instead tap Retake to try 
again. Note that the photo won’t 
appear in Photos on your iPhone.

Scan Documents with Continuity 
Camera
Document scanning with Continuity 
Camera seems more useful than 
taking photos, since I seldom need a 
one-off photo that I can take while 
sitting near my Mac. I’ve long used my 
iPhone instead of a scanner, and 
Continuity Camera makes that even 
easier. Be sure to have your 
documents ready on a well-lit surface, 
and then follow these steps:
1. Control-click your Desktop.
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2. In the contextual menu, choose 
Import from iPhone > Scan 
Documents.

3. Again, you’ll see a dialog or 
popover, and a Camera app 
variant opens on your iPhone. This 
one offers a few more options than 
Take Photo:

• Flash: As I explained above, 
tapping the flash  icon lets you 
lock the flash on or off. The 
default is auto.

• Filters: Tap the Filters  icon to 
choose which sort of scan to 
take: color, grayscale, black and 
white, or photo. The default is 
color.

• Auto: By default, the scanner 
will snap a picture automatically 
when it detects a document, but 
tapping the Auto link lets you 
change that to manual.

4. Once your options are set, center 
the document in the viewfinder, 
and if Auto is enabled, it will 
capture the image automatically.

5. If you’re capturing the document 
manually, tap the shutter button. 
Drag the four circles to adjust the 
corners if necessary.

6. If the scanner captured an image 
you didn’t want (as happened in 
my video), you can tap Retake to 
go back.

7. Tap Keep Scan to add the scan to 
your queue.

8. For a multi-page document, you 
can continue scanning subsequent 
pages. Each additional scan is 
added as an extra page to the 
document. When you’re done, tap 
Save to transfer your scans to your 
Mac as a PDF. Again, the scanned 
document is not saved anywhere 
on the iPhone.

It’s tempting to import directly into 
apps, and for a quick photo or single-
page scan, that should work well. 
However, if you’re like me, you might 
prefer to import photos and scans to 
the Desktop first, and then drag them 
to their eventual destination. That 
approach gives you another copy of 
the file, which may provide more 
flexibility or security—you never know 
when you’ll need a photo or scan 
again.
As with many other Continuity 
features, Continuity Camera can be 
fussy. Its contextual menu commands 
sometimes disappeared, presumably 
due to communication lapses. Once 
when scanning, tapping the Save 
button did nothing—this might also 
have been an indication of a 
communication failure. And another 
time, it just threw up its hands.
Nonetheless, we’ve found Continuity 
Camera to be among the most useful 
features of Mojave. Although we’re still 
recommending that most people hold 
off on upgrading to Mojave, once you 
take the leap, be sure to give 
Continuity Camera a try!

 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macOS Mojave review: At the inflection point
JOSH CENTERS 
https://sixcolors.com/post/2018/09/
mojave/
We’re taught that good things come to 
those who wait, but delaying 
gratification is no fun. It’s easier to eat 
the marshmallow now rather than wait 
for the cookie later.
And yet sometimes patience is 
required. Apple seems to have 
embarked on a years-long effort to 
update the Mac into a computing 
platform that makes more sense in the 
era of touchscreen devices, and in 
macOS Mojave we see the first 
glimmers of that effort. But the truth is, 
we don’t get to eat that marshmallow 
this year. Next year, when third-party 
app developers will get to bring their 
own iOS apps to the Mac, we may all 
get a cookie.
While that’s all going on under the 
surface—and make no mistake, 
there’s a lot going on in macOS 
Mojave that’s largely invisible but 
incredibly important to the future—it’s 
up to Apple to add visible, fun new 
features to its annual operating-
system update to help motivate 
everyone to update.
On that front, Mojave delivers an 
entirely new desktop theme—Dark 
Mode—along with the first official 
changes to the macOS/OS X color 
scheme in years. The Finder, the app 
that’s the hub of the Mac experience, 
has gotten several new organizational 
upgrades. Even Automator, part of a 

macOS user automation story that 
was seemingly abandoned, has gotten 
a few new features that make it more 
accessible to users.
Yes, macOS Mojave is probably 
destined to be known as the beginning 
of a journey, rather than a milestone. 
This is a release that has a lot to say 
about the future of the Mac. But the 
present’s been given a new coat of 
paint and some useful new features. 
And perhaps most importantly, after 
several months using prerelease 
versions of Mojave, I’m happy to 
report that it also has been a stable, 
drama-free update.
A new look
In 2014’s Yosemite release, Apple 
added the ability to turn the Mac’s 
menu bar black, a perplexingly limited 
design flourish that didn’t extend 
beyond the menu bar and Dock. 
Mojave finally makes good on the 
promise of a true dark theme for 
macOS, one that can (optionally) 
change your Mac’s windows to be 
predominantly dark with light text, 
rather than light with dark text.
Why go dark? For some people the 
answer will be novelty, or the sheer 
coolness that comes from going from 
an Imperial Stormtrooper color 
scheme to one befitting Darth Vader. 
But dark themes have long been 
popular in software that caters to 
content-generation professionals, who 
prefer to have their images or video 
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not be swamped by a lot of bright 
interface chrome. (Apple’s pro apps, 
Final Cut and Logic, both received 
dark-interface updates in the past few 
years.) Even if you’re not a pro, you 
may appreciate an interface theme 
that makes your photos and 
documents appear to pop out of the 
screen more, because they’re framed 
by darkness rather than sitting on a 
bright white background.
The Dark Mode design itself isn’t just 
an inverted version of the light mode; 
Apple has made a bunch of subtle 
design changes, including a different 
shadow, a very subtle light ring around 
the dark window to increase the 
definition of window edges, and a 
subtle background color that picks up 
an average color from the items that 
are behind it.
Your favorite apps won’t automatically 
take on the dark appearance, 
however: app developers will need to 
update their apps to support dark 
mode. Of course, Apple has already 
updated its own apps to support the 
new dark appearance, though even 
there you may be surprised at some of 
the quirks you’ll find. The fact is, a lot 
of app design (and content design on 
the Internet) assumes a standard 
black-on-white interface, and those 
assumptions can be laid bare when 
you enter Mojave’s dark mode. Apple 
Mail offers a preference to display 
message content in dark mode (it’s off 
by default), but if you’re viewing a 
richly-formatted HTML email 

message, you’ll see it rendered in its 
usual white-background style.
Once you’re used to dark mode, 
content that doesn’t follow that 
sensibility sticks out even more. It 
feels like it will take a while for the 
dark interface to feel truly, consistently 
dark—not just in terms of apps being 
updated and redesigned to support 
the new appearance, but also in terms 
of how web design is impacted. There 
will need to be a method for web 
designers to create dark themes for 
their sites (not just for Mojave, but for 
the dark theme in Windows 10, and 
perhaps a future version of iOS as 
well).
Until the world stops assuming that 
everyone wants to see black text on a 
white background, however, Dark 
Mode is kind of a flop, at least for the 
range of apps that I use to do my job 
every day. Your mileage may vary. 
Most of the apps I use are garish and 
bright, and while some of them are 
customizable, others—including many 
of the emails I receive and the 
webpages I visit are not. The contrast 
between them and the dark portions of 
the interface is painful. I can’t use 
Dark Mode when so much of the world 
insists on being light.
If the world doesn’t move in that 
direction, perhaps Apple needs to start 
taking steps to transform content 
itself. iOS offers a feature, Smart 
Invert Colors, that allows apps to 
invert some content (like, say, black 
text on a white background) while 
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preventing other content (images, for 
example) from being inverted. It’s a 
hack, but I’d love to be able to tell Mail 
and Safari to smart invert webpages 
with a bright background. In the 
meantime, it would be a good idea for 
individual Mac app developers to 
make sure their apps look good in 
both modes. And, one would hope, for 
web standards bodies to move 
forward with support for alternative 
style sheets for different operating 
system design themes.
Speaking in new accents
Speaking of features that seemed ripe 
for elaboration but never got it, since 
the early days of Mac OS X there’s 
been the concept of an appearance 
color, but your only options were Blue 
and Graphite. Blue was the standard 
Mac OS X interface; Graphite 
removed colors from places like the 
“stoplight” icons in the title bar of 
windows and emphasized shades of 
gray. It always seemed like one day 
Apple would expand beyond the 
single color option, but it never 
happened.
Mojave, though, puts a spin on this 
idea by introducing the concept of an 
accent color, so that a bunch of 
interface features (the buttons at the 
end of pop-up menus and highlights 
on selected menu items, for example) 
can be colored something other than 
blue—you’ve now got a choice of 
eight different colors. The concept of a 
highlight color (the color that shows 
when you select text) still exists, 

though, and so if you want your menu 
bar accents to be orange but your text 
selection to be blue, you can do that.
One of the delights of being a Mac 
user is being able to personalize your 
computer interface so it’s undeniably 
yours. Adding two different 
appearance types and a selection of 
accent colors is a nod from Apple to 
this fact, and while it’s long overdue, 
I’m very glad that it’s in Mojave. I 
spent all summer with orange 
highlights everywhere on my iMac 
Pro, and you know what? It was really 
fun. Sometimes it’s good to have fun 
when you’re using your computer.
Moving iOS apps to the Mac
Viewed on its face, the addition of four 
new Apple apps to macOS is 
welcome. I’m not a big fan of Stocks 
or Voice Memos, but they’re available 
on iPhone and it makes sense to 
spread them across all of Apple’s 
platforms (including iPad) and sync 
them with iCloud. News is an strategic 
app for Apple, and it’s been missed on 
the Mac the last couple of years, so 
it’s good to see it arrive.
Most of all, the Home app—and 
accompanying Siri support for 
HomeKit—is a big winner for those of 
us who use Macs in a home filled with 
HomeKit devices. I can’t tell you how 
many times I’ve had to go into another 
room to find an iOS device in order to 
turn a HomeKit device on or off… 
when I had my Mac sitting right in 
front of me. It’s great to be able to 
adjust lights and thermostats and all 
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sorts of other smart-home stuff from 
right on my Mac.
Delve a little deeper, though, and 
you’ll start to notice that these apps 
don’t really feel like native Mac apps. 
The Home app displays the iOS date 
and time picker—you know the one, 
where you spin the wheels with your 
finger—and I can’t begin to explain 
just how wrong that is on the Mac. 
(You can click very gingerly on the 
wheels to move them, or hover the 
cursor over them and scroll up and 
down with two fingers.)
Every app is a single window. 
“Windows” generated when you need 
to set preferences are modal, appear 
in the center of the existing app 
window, and can’t be moved—and of 
course they can’t, because they’re not 
really Mac windows and these aren’t 
really Mac apps. They are iOS apps, 
translated into Mac apps via a method 
that will be available to non-Apple 
software developers next year.
This move has major ramifications for 
the future of Mac software. All iOS 
apps are developed on macOS, but 
even veteran iOS developers can find 
it a difficult transition to writing macOS 
software. Using Apple’s as-yet-
unnamed approach, it should be much 
easier to bring iOS apps over to enrich 
the Mac. I like that Apple is testing this 
approach itself before handing it out to 
everyone else, because there’s clearly 
a lot more work to be done—not just 
in fixing bugs before Mojave ships this 
fall, but in the next year to make sure 

that iOS apps translated to the Mac 
behave properly and work well.
Having the News app on the Mac is 
great for people who use it on iOS, but 
as a Mac app, it’s not great. It does 
the job, I suppose, and it’s better than 
nothing, but… that’s about it. Let’s 
hope that Apple’s plan is to continue 
refining the technology they’re using 
to bring iOS apps to the Mac over the 
next year, so that these apps can feel 
more native to the platform. The 
promise of bringing iOS apps to the 
Mac is great; the threat that they might 
be really bad is also great.
We’ve got a year to ponder what the 
future of the Mac might be, whether 
bringing apps designed for 
touchscreens augurs the arrival of 
touchscreens on the Mac, if iOS 
developers will bother to put the work 
in to bring their apps to macOS, and 
any number of other ruminations. In 
the meantime, at least I can turn my 
lights on and off from my Mac now.
A view from the Gallery
What makes a Mac a Mac? At the 
center of the Mac experience is 
interacting with the filesystem via the 
Finder. (Compare this to iOS, where 
app launching is at the center, with file 
access consigned to the Files app.) 
Yet it’s been a while since Apple 
lavished any attention on improving 
the Finder experience. But in Mojave, 
the Finder gets the attention it 
deserves, with a new view option, 
upgrades to Quick Look, and several 
improvements to the Finder’s most 
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important piece of real estate: the 
Desktop.
Cover Flow view, a Steve Jobs 
favorite that displayed previews of 
files above a list view, is no more in 
Mojave. (Did you know it was still 
there?) It’s been replaced with the 
new Gallery view, which displays a 
very large preview in most of a Finder 
window, with a strip along the bottom 
showing thumbnail previews of every 
item in the folder.
To the right is the Preview pane, which 
has existed for a while now, but it’s 
been upgraded to display a wider 
selection of metadata associated with 
the selected item—both general file 
information (date created and 
modified) and context-specific content 
information (for images, it shows 
dimensions and color profile). A new 
option in the File menu, Show Preview 
Options, lets you set specifically what 
metadata gets displayed in that pane.
I have a hard time imagining how I’d 
use Gallery view broadly, but it’s 
perfect for folders of images or PDFs 
or videos or other media types where 
the content is more important to 
browsing than the filename, creation 
date, and size.
There’s also a surprising twist: At the 
bottom of the Gallery view, there are a 
set of Quick Action buttons that let you 
modify the item you’re looking at, 
without opening any apps. Rotate or 
mark up an image, trim an audio or 
video file, or act upon just about any 
file type using an automation that you 

built yourself. (More on that in a little 
bit.)
I have to admit that it gives me pause 
to imagine the Finder as a place 
where you modify the content of 
documents, but it just makes sense. 
Why open an app to rotate an image 
file or quickly trim a video?
The ability to modify files isn’t limited 
to buttons in Gallery view, either. If 
you keep the Preview pane visible in 
list or icon view, you’ll see a preview 
of the item and have access to the 
same Quick Actions. And some of 
these commands also appear in Quick 
Look, where they appear as buttons at 
the top of Quick Look windows. So 
even if you’re viewing a folder in Icon 
view without the Preview pane 
selected, you can press the spacebar 
to view an image file and then rotate it 
or mark it up, right from Quick Look.
A pile of Desktop features
Here are two facts about me: I’m the 
kind of person who puts a lot of files 
on his Mac’s Desktop, and in the real 
world I am a somewhat messy person 
who tends to make stacks or piles of 
papers, books, and the like, rather 
than actually file or shelve them. It 
never occurred to me that you could 
combine my digital and analog 
organizational tendencies, but Apple 
has done it in Mojave by applying 
some basic piling techniques to our 
messy Desktops.
This comes in the form of a new 
feature called Desktop Stacks, which 
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borrows the Stack concept from the 
Dock and applies it to the files on the 
Desktop. Files can be grouped by kind 
(Documents, Images, PDFs, Music, 
Movies, Other), date (last opened, 
added, modified, or created), or tags. 
Folders are left untouched.
Even the messiest desktop will get a 
lot cleaner when all the files get 
sucked into one of these Stacks, 
which is the size of a single file icon. If 
you hover the cursor over a Stack and 
swipe left and right on the trackpad, 
the Finder will step through the 
contents of the Stack one at a time, 
with the filename and preview icon 
appearing in place of the Stack name 
and icon.
If you click on a Stack, it expands, 
with the contents of the stack 
appearing below the stack icon itself. I 
found this approach a little confusing
—I think I’d prefer all the items to 
appear in a popover, as they appear 
when you click on a Stack in the Dock, 
or as a folder. Instead, the icons on 
your Desktop just increase 
temporarily, with the new icons 
pushing the old ones farther down or 
to the left.
In any event, once a file is visible, you 
can double-click on it, select it and 
drag it elsewhere, view it with Quick 
Look, or basically everything else you 
expect. (Unfortunately, when you 
move the cursor away from the top of 
the stack, the stack collapses, making 
it impossible to use your cursor to 

interact with the Quick Look window. 
That’s not great.)
I actually keep my desktop organized 
enough that I can’t envision using 
Desktop Stacks as it’s currently 
designed. The feature would probably 
benefit from added flexibility in how to 
group Stacks; for example, right now 
I’ve got a half-dozen PDFs on my 
Desktop, but they just get poured into 
a Stack called Other with various 
other miscellaneous file types. Using 
tags would be a workaround, which I 
might consider if things get unruly—
but the thought occurs to me that this 
is a feature primarily for people who 
haven’t organized their Desktop and 
aren’t going to start. Desktop Stacks 
probably aren’t going to transform 
most Mac users’ personal filing 
systems, but they might make it easier 
to find a file on the Desktop, and that’s 
the point.
If you’re a messy person whose files 
litter the Desktop, you might not even 
realize this, but there’s generally a 
pretty picture back there. Apple has 
complicated the simple concept of a 
Desktop picture in Mojave by adding 
what it’s calling a Dynamic Desktop, 
an image that shifts over time (and 
changes immediately when you switch 
into Dark Mode). Mojave comes with a 
two Dynamic Desktop images, one of 
a sand dune in the Mojave desert with 
different creeping shadows throughout 
the day, one of ever-changing color 
gradients reminiscent of sunrise and 
sunset. (There’s also an option to 
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choose a backdrop image of the 
desert, which turns into a still of the 
desert at night when you’re in Dark 
Mode.)
Dynamic Desktop pictures are not a 
new phenomenon—people have been 
making apps that do this for ages. But 
now it’s a fundamental part of macOS, 
which is interesting. The Mojave 
Dynamic Desktop is made up of 16 
different still images packaged 
together into a HEIC file, which is a 
container file for the HEIF image 
format Apple adopted last year across 
macOS and iOS. Someone has 
already reverse-engineered the format 
and built a tool to let you build your 
own; the author of that tool generated 
a Live Desktop of Earth as seen from 
space and it’s pretty cool.
Quick Actions get automated
When Sal Soghoian left Apple, I 
assumed that we’d never again see 
new features that extend support for 
user automation in macOS. 
(Meanwhile, iOS 12 has Siri 
Shortcuts, which are extremely 
exciting.) In any event, I was 
completely wrong: macOS Mojave 
increases the visibility of the user 
automation feature I use every single 
day on my Mac, putting it front and 
center in several different parts of the 
Finder.
That feature used to be called 
Services, and it let you build an 
Automator action that can run in any 
app, but most notably the Finder. 
Services can be run from contextual 

menus in the toolbar of Finder 
windows, via a control-click, or even 
an assignable keyboard shortcut. 
Those actions can do just about 
anything, including run Automator 
commands, AppleScript scripts, shell 
scripts, or any combination thereof. I 
use them to build simple Finder 
commands that perform complex 
actions on the files or folders I’ve got 
selected. They have saved me vast 
amounts of time.
In macOS Mojave, Services plug-ins 
in Automator have been renamed as 
Quick Actions, and their visibility has 
increased. Quick Actions appear in the 
Preview pane in the Finder, alongside 
other commands like Apple’s own 
Rotate Image and Markup commands. 
Automator has been updated so you 
can assign an icon to each Quick 
Action so that it’s easier to 
differentiate them from one another. 
(You can choose from dozens of icons 
provided by Apple, or add your own.)
Quick Actions can also appear in the 
Touch Bar, courtesy of a new Quick 
Action icon that you can add to the 
Touch Bar’s Control Strip. Tap on that 
icon and the Touch Bar will display the 
icon and name of your Quick Action 
Workflows. (Ones you can’t currently 
use will be grayed out, which wastes a 
lot of Touch Bar space—it would be 
better if unavailable Quick Actions 
vanished so that other ones could 
appear.) You can customize which 
items appear in the Touch Bar list from 
the Touch Bar section in the 
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Extensions pane of System 
Preferences.
For those of us who use Services 
today, this is a nice addition that will 
let us surface them more visibly in a 
few different places in the Mac 
interface. I have to admit that I’m a 
little hopeful that it might actually 
increase the visibility of the feature 
itself, because it’s incredibly powerful 
and has the potential to save a lot of 
people an awful lot of time.
And the Rest
As with any operating-system release, 
there’s always a grab bag of other 
features, little improvements here and 
there that aren’t necessarily the most 
eye-catching, banner features, but still 
have an impact. Mojave is no 
different.
Screenshots. Apple has built a new 
screenshots interface behind the new 
shortcut Command-Shift-5. 
(Command-Shift-3 and -4 still work as 
always.) When you choose 
Command-Shift-5, a floating palette 
appears with options to capture the 
entire screen, just a window, or just a 
portion of a window—all features you 
could already perform, but only if you 
knew the right combination of 
shortcuts. Providing visible options is 
a much friendlier experience. There 
are also options to start a screen 
recording, a feature that previously 
was integrated into QuickTime Player 
but now is more sensibly included 
here. Finally, there’s an Options menu 
that lets you choose where to save the 

resulting screen shots (including to the 
Clipboard), and if you want to use a 
timer to delay when the screen shot 
gets taken (a feature previously 
available in the venerable Grab app).
When you take a screen shot, by 
default you will see an iOS-style 
floating thumbnail in the lower right 
corner of the screen, which you can 
click to open Markup and quickly edit 
or discard the image. If you don’t like 
this intrusion—for instance, when 
you’re taking several screen shots in a 
sequence and don’t want the floater to 
appear in any of them—you can turn 
the feature off from the Options menu.
Continuity Camera. Once you accept 
the premise that we have a 
constellation of devices around us all 
the time, software can be built to take 
advantage of that fact. Using the 
Apple Watch as a biometric 
authenticator to unlock Macs is a good 
example. With Mojave, the portable, 
high-quality camera in our iPhones 
becomes a feature of the Mac. Apple 
has updated several apps, including 
Notes, Mail, and the iWork apps, so 
they can directly insert images 
gathered by an iPhone on demand. 
For example, in Notes you can choose 
Take Photo or Scan Documents from 
an “Insert from iPhone” item in the File 
menu. Your nearby iPhone will spring 
into action, letting you quickly capture 
an image or document, which is 
transmitted to your Mac and inserted 
right where you asked for it.

Apple Bits �13 September ’18



I hope this feature is adopted by other 
apps, as well—once you start thinking 
of your iPhone as a peripheral image 
capture device for your Mac, it gets 
frustrating to have to go back to taking 
photos and then AirDropping them to 
your Mac.
Mac App Store. The Mac App Store 
has been around for more than seven 
years now, and it has never proven to 
be the powerful force in driving Mac 
software sales that the iOS App Store 
has been for iPhone and iPad 
software. This year Apple’s taking 
several steps to improve the 
relevance of the Mac App Store, with 
a new App Store app that’s been 
redesigned to feel more like its iOS 
counterpart, complete with better 
graphics and ongoing editorial content 
about Mac apps, and new categories 
focused on key areas of the Mac, 
including apps tailored for creative 
professionals.
With Mojave, Apple is also broadening 
the privileges Mac App Store apps can 
ask for, allowing more full-featured 
apps to get into the store, including 
Panic’s Transmit and Bare Bones’s 
BBEdit. And next year, of course, we’ll 
start to see apps currently available 
only on iOS appear on the Mac.
This really feels like a new start for the 
Mac App Store, but it will take time for 
developers to decide if getting in the 
store is worth the effort. From a user’s 
perspective, the Mac App Store app 
looks quite good, and if the regular 
features written by Apple’s in-house 

editorial group can maintain the high 
quality generated the past year in the 
iOS App Store, it will be worth it to 
launch the App Store app on the Mac 
just to see what’s going on. It’s a start.
Security improvements. Taking 
some cues from iOS, Mojave limits the 
access software has to your Mac’s 
microphone and camera. Each app 
that wants to use those devices must 
ask and receive permission from the 
user before doing so. Many apps will 
also need to ask before accessing 
application data (such as mailbox files 
for Mail), or running automation 
routines. Will this lead to a Windows 
Vista-level of user annoyance? I sure 
hope not. I know that apps that relied 
on AppleScript for some features have 
actually rewritten those functions in 
order to avoid annoying users. After a 
few initial permission boxes, my Mac 
running Mojave has settled down. 
Here’s hoping that continues.
Safari tweaks. Every macOS release 
brings improvements to Safari, and 
Mojave doesn’t disappoint. Safari will 
now automatically generate and insert 
strong passwords whenever you’re 
signing up for a new account on a 
website. (You can also audit your 
passwords to find reused ones and 
change them via the Passwords 
section in Safari’s preferences 
window.) When you receive a text 
message with a code meant to be 
entered in as a part of a multi-step 
authentication process, Safari will 
automatically fill that code in. The app 
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has been modified to make it even 
harder for people to track you across 
different websites. And finally, you can 
now opt to display favicons in browser 
tabs.
Mail improvements. Apple Mail will 
now suggest folders for you to file 
messages in based on your behavior, 
which is a really cool feature that I 
wanted back when I was filing 
messages in folders. (This is actually 
a feature that existed in High Sierra, 
but only appeared in the Touch Bar, 
while it’s now at the top of the Inbox 
view.) Also, there’s now an emoji 
button so you can more easily get to 
emoji when you’re composing emails.
Recent apps in Dock. The Dock, 
another huge part of the Mac 
experience, hasn’t changed as much 
as the Finder, but there’s been one 
iPad-inspired improvement: Now to 
the right of your favorite apps, there’s 
a new section for recently used 
applications. If you launch an app that 
isn’t currently in your Dock, it now 
appears in this section… and might 
even stick around after you quit it.
Photos. The Photos app got a major 
upgrade… on iOS 12. The Mac 
version is largely unchanged, though 
it’s got a few new keyboard shortcuts. 
The big change is that Apple’s 
discontinuing its own support for 
printed books, calendars, and prints. 
Instead, you’ll need to rely on third-
party extensions to get your photos 
down on paper. There aren’t a lot of 
great choices, unfortunately. I had 

success with ordering a photo book 
from Mimeo, and am in the midst of 
testing a new extension from Motif. I’ll 
have a lot more to say about the 
changes to Photos for Mac in the days 
to come.
A moment in balance
macOS Mojave is an update that 
straddles the line between past and 
future. It feels very much like the first 
era of Mac OS X has drawn to a 
close. What comes next will almost 
certainly be informed by the success 
of iOS and powered by apps that got 
their start on that platform. It’s entirely 
possible that in five years, Macs will 
have touchscreens and run on Apple-
designed processors. Whatever the 
details, the Mac has begun to turn into 
whatever it will be for the next phase 
of its life.
But for today, Mojave reflects the fact 
that Apple seems to be lending 
attention and energy to macOS for the 
first time in a while. Dark Mode and 
other interface changes give us all 
more choices about how we want our 
Macs to look, and tweaks to the 
Finder go to the core of the Mac 
experience. (I’m also happy to finally 
be able to control my HomeKit devices 
from my Mac, either via the Home app 
or Siri.)
[If you appreciate articles like this one, 
help us continue doing Six Colors 
(and get some fun benefits) by 
becoming a Six Colors subscriber.]
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Joy of Tech
http://www.joyoftech.com/joyoftech/
joyarchives/2542.html  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Membership Renewal Form  
For those members who wish to 
mail in their renewal, simply print 
and fill out this page, include check 
or money order for $20 (made out 
to NEO Apple Corps) and mail to:


NEOAC

P.O. Box 361782 

Strongsville, OH 44136


Name (first last):


__________________________________


Email address (Please include even if 
opting out of Google Group, so an  
acknowledgement of the receipt of 
your check can be issued; a written 
receipt will be available at the next 
meeting.):


Street Address:


__________________________________


City, State & Zip Code: 


__________________________________


New or Renewal: check one

New

Renewal

Lifetime member


Are you part of a family membership? 
check one


No

Primary member (the one who 
paid)

Secondary member (everyone 
else)


What Apple products do you own?

(e.g. Mini, MacBook, iPhone, iPad)


__________________________________


What is the primary OS you use?

(e.g., Snow Leopard? Lion? Mountain 
Lion? Mavericks? Yosemite? iOS? 
Other?)


__________________________________


Years using a Mac: check one

less than one year

1-3 years

More than 3 years


Opt out of Google Group

Do you want to receive listserv email?


Yes

No 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